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® Answer all questions in this paper itself.
® Write the answers clearly and legibly in blue or black ink only and not in pencil.

One hour

Index No. : oovriineiiiiiiiinennn

1. Define the duties of an ‘office’ according to the definition given by ‘E.C. Ayre’?

....................................................................................................................................
....................................................................................................................................
....................................................................................................................................
...................................................................................................................................

....................................................................................................................................

2. Management experts are of the view that there are advantages and more disadvantages caused by the
use of office systems in government offices. Write five definite disadvantages that can be caused by
using office systems.

[ See page two D
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4, Briefly explain the following.

(i} Why should the task sequence system be used and re—created in order to simplify office systems?

AtbrrreararsanmavnuLrae D T L T L R R P LT RT YRR

(05 ‘marks)

S. Briefly describe what is an office inspection and state the two main methods of conducting an office
investigation?

sanastbbivrarrevanetananas I T R N N T L PSR EE R bl st asnanas
Trserresasrrnnnans tevraranramsnavesans 4dararirasarerereinnaans B e
-------- M T
tiveresnianratannnas R N I T T Frtdranrenansnterrcacnnsunnn RitttevumnntaTansssreutanan IR R TR R
........ e e R R B
----- e R L R L L L h L L Tt
ttvrraassrsunaas D R B R T T T T T Settrrrirarinsrannasesana
............... e e

6. Write three advantages and three disadvantages of indexing files?

Advantages € T Creriarerereaenies Chesteererenreererraniries

Disadvantages (i) ................ v atresreereearienans

() vvrvavrnnernennes et trrenreareianrenns Cereeirraeraraerans et tteareaneianeaans e brreaneaeee e, ..

(05 marks)
e J
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7. State five principles that should be considered in preparing common formats for public offices.

() i e N r s b e dr e aa e aeaaeiaras B S ettteereinsennannanes
..............
() v N e e erees e et ataearaares Yt ettrreraieerreaererianennnianas
.............
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.............
(V) i r bt brransrennererteeraanaennearns i rerteerennes idrbanereneeetennnaan cerneees
treerrenerara. v et teibiaeeriaanteeateeiinateaniraas et teerrrereereraiaateeriaaatesarans cereenn Cebtramerrreeeeanes

TILEEL L) vesrrararnereante wraran BEtl4tvurrasrienranrre s nnanusnnns FLtdacrarrrraraTaansae T TaT AR NIRRT AN LS ITEE) trratidsrnsnann
-------------- R R R L L L LT L L T LT T P,
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.......................... R N N T I I I T I T,
................. L R N R R L E L E Ll L T T Y
...................... L R L R R L L L L T r L U,
...... AR A R I IIImmmm I TTImTTrm I T TN
bersnasarerTrertinnRuas raareas Aertlaarareascaeverusananarans R N PR R T P Tanns Tt bearraaraiannserane
----------------- R R R R R NI rIImmmmmm I T T, T
............ LR R e N L I I I T T I I T

(10 marks)
9. There are fifteen important documents thai an officer should pay attention to when assuming duty for
the first time or assuming duty after a transfer, Name ten of them.

() vovieiercr e, i eaaeer e a et aaaaans b ereranreearraa it reneairrrirans e caten e reeiaran

(X) e e treeeerre e, ek reTeettibr e ranaeaaans cevreeaen Nt ehesar e rasiteanraaas

\__ (10 marks)/
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i1.

12.

What are the qualities that should be appeared in an accurate filing system?

......... M R R e NN T N R e L EEEE E T L L T T O
praran sveans R T ArrttaEranan tarsiteavensnura Nrusersstessurraan +ARSEE bt s s anan seesa Fresstittnaraanane .
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.................... A R T N L L LT T LT T T
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....... CsasLursaana b M R
------ e

(10" ‘marks)

Describe in detail the documents that should not be sent to an archive?

e R N N N R L L L EE T o, R N L L thrasrrinsasnsana .
R N L L R L N T sresritran ittt D
Arerrirerinna Srsdmrurrrananvean Yerersaran R I I thvseurarann *rsrssnnsansanans L YT T )
Aretrauean L R tedbraran srrevusnmruaa Ttbrrraan R T S S D P essrasassssaan
T TR T e seenunn ttrvresriassravasanas tdrerraiacantarsrenne trvremrsranrasvantanaan teranrrana D
e R
R TR Tassesse tesrrvana D T T T ¥ Ry erersan D T Nevas Tt sutanann nennesan
srsinans T vrurareanaan srasavsana trrrearaasarsanans ttvarsvresane nesetennnna Naere tererranaans renn
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tasbrrarrian e as et e arEnrEEtdR b b A s aaaa A d Il er e st L b urararaainv R AR I R IR I

(15 marks)

What are the facts that should be taken into consideration in issuing copies of official letters and
documents?

TatusEREtssennssrrnrnns “rtianna T Tetarnnann TesesusatEtaarranan ressuns dsbrrrrrsatransnsinaanna XX P T TR R e

Srrsttasrsasssnnaa raa R L L N A e
' I R T sesn R R Yt atraennaan Paetberans vas
srsenmnna L R 4bturannsertusesns drerriatasusatraneananannn TS Arar et E A edn s asnaay R N R R R R TR T
R T aremana I D DR
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® Answer all questions in this paper itself.
@ Write the answers clearly and legibly in blue or black ink only and mot in pencil.

Index No. : ....ccoovvviviniiiinnnnn.

1. State four sources of Finance used in the preparation of Annual Budget.

(08 marks)

2, State four types of limits relating to the Advance Accounts shown in the Annual Estimates.

3. State four types of receipts that are not considered as state revenue when preparing the Estimates of
Revenue.

(1) et e e ettt e ———

(D) e e e

[ See page two O
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3. Mention four methods of Procurement to be used in obtaining goods and service according to the
procurement guidelines,

{ 08 marks)

6. Mention four types of statutory deductions that could be made from the salary of a government officer.

(08 marks)

7. Mention four stages of Delegation of Financial Authority in relation to expenditure in terms of
ER. No. 135,

(08 marks)

8. State four matters for which the prior authority (approval) of the Deputy Secretary to the Treasury is
required for Posts, Cadre, Scales of salary, etc in terms of FR 71.

9. State four types of sources of Laws (Regulation) to be followed up in the process of “payments” in
a Government Department,

L O OO PO OOV RURURPR

(i) oot et e et eere e et et eaeaete e ——————

(I e e e ettt etk e e e et e e e e ee et e rereee e rr e

L3 T U OU TSR

(08 marks)

o J

[ See page three. D



-3-
- ™\
10. State four types of ‘warrants’ signed by the Minister of Finance to release money from the Consolidated
Fund.

PEres bt bune

{08 marks)

1l. State five matters to be followed up when a cheque, deposited by a Government Department, has been
dishonoured by the Bank.

...................

(10 marks)

12, Mention five matters, a second signatory to a cheque, issued by a Government Department is responsible
to the Accounting Officer.

(10 marks)
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( A
B For questions from No. 1 to 50, select the correct or the most appropriate answer and write the
number of the relevant choice on the dotted line provided against the question.

1. Which of the following are good precaution / precautions to take against virus infections in
computers?

A — Usage of good anti-virus software
B -~ Not opening email attachments from unknown sources
C - Backing up files systematically
(1) A only (2) B only (3) C only (499 Al A, Band C  (......... )

@ To answer questions 2 and 3 consider the following CPU specifications labelled A, B, € and D:

A - AMD FX 6300; 3.5 GHz; Hexa core

B — Intel Core i3 3220; 3.3 GHz; Dual core

C - Intel Core i5 6200U; 2.3 GHz; Dual core
D — Intel Core i7 6700K; 4 GHz; Quad core

2. Which of the above has the highest clock frequency?
n A (2) B 3 C 4 D (convvnnnn )

3. Which of the above has the highest number of processors per chip?
(1y A (2) B 3 C 4 D RPN )

4. Which of the following will increase the lifetime of a desktop computer?

A — Protecting it from undesirable environmental elements like dust, water, extreme
heat etc.

B — Using a voltage stabilizer to protect it from power fluctuations
C — Protecting it from hard shocks
(1) A only (2) B only (3) C only (4 All A, B and C TP )

5. Following are some ports in the back panel of a computer:
A £

! | i i

B 4] £ F H

Assume that the following have to be connected to the above computer:

# A USB device

#% The keyboard cable

% The network cable

# The VGA cable (from screen)

Which of the following gives a suitable port matching for the above?
(1) USB device: A, keyboard cable: B, network cable: E, VGA cable:
(2) USB device: B, keyboard cable: A, network cable: G, VGA cable;
(3) USB device: C, keyboard cable: E, network cable: F, VGA cable:
(4) USB device: D, keyboard cable: F, network cable: C, VGA cable:

=00

6. Which of the following is an operating system that can be obtained free of charge?
L {1) Mac OS (2) Linux (3) Windows 10 (4) Windows Vista | (PR )

[See page three D
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7. Assume that your internet connected computer has both Microsoft Windows and Linux operating
systems but Microsoft Office is not installed in it. If you have to type a document on it which
of the following options could be taken?
A — Using Google Docs
B — Using Libre Office Writer through Linux
C - Using Microsoft Excel
(1) A and B only (2) A and C only
(3) B and C only (4 All A, B and C T COTT )
8. Consider the use of computers for the following requirements:
A — To be used at the check-in/check-out desk of a library
B — To be used by a writer to work on an essay during his vacation
C - To be used by a sales representative who has to travel extensively as part of his
work _
Which of the following gives a suitable computer combination o match the above requirements?
(1) A : a desktop computer, B : a laptop computer, C : a tablet computer
(2) A : a laptop computer, B : a tablet compuler, C : a desktop computer
(3) A : a tablet computer, B : a desktop computer, C : a laptop computer
(4) A : a tablet computer, B : a laptop computer, C : a desktop compuier (covernnns )
9. Sama who works at the A.G.A. office at Wassanagama wants to select a password for her
account on her office computer. Which of the following is the most suitable password choice
for her?
(1) agawassa (2) samal234 (3) Bjr!*7 {4) wassalll [ CPTO )
10. Which of the following is a false statement regarding the Microsoft Windows system interface?
(1)} ‘Hardware and Sound’ is not an item in the Control Panel window.
(2) Recycle Bin contains all non-permanently deleted files.
(3) The Word application can be started by following All Programs —» Microsoft Office
—» Microsoft Word.
(4) Windows Explorer allows io see the contents of different folders in the computer. (ovrvrnnn )
11. Suppose you just finished working on Microsoft Word and you saved your document in
your USB flash drive. Before shutting your computer down, you remember that you were
recommended to do the following tasks:
A — Exit from Microsoft Word.
B - From the Windows Task Bar, select Show Hidden Icons —» Safely Remove
Hardware and select the relevant USB flash drive.
C - Pull out the USB flash drive.
Which of the following is the preferred order of the above actions?
(1) A, B, C " (2) A, C, B (3) C, A B 4 C,B, A (e )
12. What will result respectively when pressing each of the following three buttons from left to
the right that appear at the top right of a window?
(1) close, maximize, minimize that window
(2) close, minimize, maximize that window
(3) maximize, minimize, close that window
(4) minimize, maximize, close that window [ (P )
\._

[See page four C]
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13. The following icons ;% - =% will mean

(1) copy, cut and paste réépectively. (2) cut, copy and paste respectively.

(3) cut, paste and copy respectively. (4) paste, cut and copy respectively. | ST )

14. In Windows Explorer, a set of files could be selected at once by

(1) keeping the Alt key pressed and pointing the mouse pointer at each wanted file and
then clicking the left mouse button.
(2) keeping the Ctr! key pressed and pointing the mouse pointer at each wanted file and
then clicking the left mouse button.
(3) pointing the mouse pointer at each wanted file and then clicking the left mouse button.
{4) pointing the mouse pointer at each wanted file and then selecting Copy from the Organize
menu. PP )

15. In Microsoft Explorer, a selected file can be permanently deleted by
(1) cutting it and pasting in the ‘Recycle Bin’.
(2) dragging it to the ‘Recycle Bin’.
{3) holding down the Shift key and pressing the Delete and by selecting ‘Yes' for the
confirmation question. '
(4) pressing the Delete key once and by selecting ‘Yes’ for the confirmation question.  CUPT )

16. A person wants to convert a single column text in his Microsoft Word file into multiple
columns. He has come to know that the following tasks have to be done in a proper order:

A ~ Select the number of columns that is needed.

B — Select the ‘Page Layout’ tab and then click the ‘Columns’ command.
C' — Select the text that has to be converted into multiple columns.

Their proper execution order should be
(1) A, B and C. (2) B, A and C.
(3) B, C and A, (4 C, B and A, Coovenennn )

17. For which of the following tasks can the ‘horizontal ruler® in Microsoft Word be used for?
A - Increase / decrease column width and spacing
B — Setting and changing margins
C - Setting and changing tab stop positions
(1) A and B only (2) B and C only
(3) A and C only (4) All A, Band C (covennans )

18. Which of the following is a Microsoft Excel file extension?
(1) .doc (2) pdf (3) ppt (4) xis Covennens )

19. To add borders to a range of cells of a Microsoft Excel worksheet the following tasks have
to be done in a proper order:
A — Clicking the right mouse button
B — Directing the mouse pointer to the relevant borders on the box that is displayed
to select them and selecting OK
C — Selecting ‘Border’ option
D — Selecting ‘Format Cells’ option
E ~ Selecting the range of cells to which borders should be added

Their proper execution order is

(1) A, C, D, B and E. (2) B, A C,E and D.

L (3) D, E, A, B and C. 4 E, A D, C and B. (T )J

[See page five B
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20. Which of the following is the correct function of Microsoft Excel worksheet to add the
numbers in the cell range A2 to G2?

(1) =ADD(A2:G2) (2) =ADDITION(A2:G2)
(3) =SUM(A2:G2) (4) =SUMPRODUCT(A2:G2) (. )

21. Which of the following is the correct function of Microsaoft Excel worksheet to compute the
average of the numbers in the cell range A2 to G27

(1) =AVERAGE(A2:G2) (2) =GROWTH(A2:G2)
(3) =MEDIAN(A2:G2) (4) =MIN(A2:G2) (coeeennn )

22. Which of the following is the correct function of Microsoft Excel worksheet to count the
number of non-empty cells in the cell range A2 to G2?

(1) =COUNT(A2:G2) (2) =COUNTA(A2:G2)
(3) =COUNTBLANK(A2:G2) (4) =MAX(A2:G2) Coaerneens )

23. Consider the following part of a Microsoft Excel worksheet:

Student Performance at Exam

Percentage
Verygood | =
Good 20
Fair 10

A pie—chart has to be made to illustrate above data. For that, the following activities have
to be done in the proper order:

A — Click ‘Insert’.
B — On the “Charts’ group, select ‘Pie’ as the chart type.
C — Select cells from A3 to B6.
Their proper execution order should be
(1) B, A and C. (2) B, C and A.
(3) C, A and B. 4 C, B and A (cevnvenes )

24. Which of the following is not a valid Microsoft Access field data type?
(1) Date/Time (2) Graph (3) Number (4) Text (ooeeeenes )

25. The primary key of a database table
(1) must be unique.
(2) must only contain numbers.
(3) should not appear in any other table of the database.
(4) should not exceed four characters. (orrrenrnn )

26. Which of the following statements are correct?

A - It is better to use Microsaft Access instead of Microsoft Excel when multiple tables
of related data are involved.

B — Microsoft Access provides a ‘Report Wizard’ to help users create reports.
C - Microsoft Excel worksheets cannot be imported to Microsoft Access tables,

(1) A and B only (2) A and C only
(3) B and C only {(4) All A, B and C (

[See page six D
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® The questions from No. 27 to 30 are based on the following database description:

27,

28.

29,

30.

31.

32.

A database dealing with authors, books and publishers consists of the following four tables.
The fields of each table are listed within parentheses:

Authors (AulD, AuName, AuPhone)
Books (ISBN, Title, PublD, Price)
BookAuthor (ISBN, AulD)

Publishers (PublD, PubName, PubPhone)

The primary keys of Authors, Books and Publishers tables are, respectively,
(1} AuID, ISBN and PubID.
(2) AuName, PublD and PubName.
(3) AuName, Title and PubName.
(4) AuPhone, Price and PubPhone. (oeeennenn )

A book may written by multiple authors and an author may write many books. Then the
BookAuthor table is used to

(1) ensure the correctness of the Books and Aumthors tables.

(2) implement the one-to-one relationship between books and authors.

(3) implement the one-to-many relationship between books and authors.

{(4) implement the many-to-many relationship between books and authors. (oveenens )

Assume that the above database is to be implemented using Microsoft Access. For that, after
starting Microsgft Access, the following tasks have to be done in the proper order:

A — Enter the data for each table (i.e., table name, field names and data type for each
field).

B — Select ‘Design View’ from the ‘View’ menu .
C - Give a name for the database.
D - Select ‘Blank Database’.

Their proper execution order should be

(1) A, B, Cand D. (2) A, B,Dand C. (3) B, C, A and D. (4 D, C, B and A.  CPPPT )

Assume that you want to create forms in Microsoft Access to facilitate data entry to the above
tables. To create a form for Books table data entry, the following tasks have to be done in
the proper order with the database open:

A — Click ‘Finish’.

B - From the ‘Create menu’, select ‘More Forms' and then ‘Form Wizard’.

C - Select the fields of the table for which the data should be entered.

D - Seclect the table (Books) to create the form for.
Their proper execution order should be

(1) B, C, Dand A. (2) C, D, B and A. (3) D, B, C and A. (4 D, C, B and A. (TR )

Which of the following is a Microsoft PowerPoint filename?

(1) 2018budget.xls

(2) 2018goals.pdf

(3) englishPunctuationRules ppt

(4} questions.doc (

An example filename extension of a video file is
(1) avi (2) .docx (3) .mp3 4) xlsx Coeeenennn )

[See page seven D
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33. Given below is the image of the top right corner of a Microsoft PowerPoint window:

The guestion mark symbol there

(1) exits the application. (2) inserts an animation.
{3) opens a PowerPoint help window. (4) starts a slide show. (... }
34. The List A gives some PowerPoint main menu options and the List B includes an appropriate
option that can be selected through List A.
List A : Al. Insert A2, Design A3, Animations
List B : Bl. Advance Slide  B2. Page Setup B3, Picture
A correct matching between the two lists is
(1) Al-Bl1, A2-B2, A3-B3. (2) Al-B2, A2-Bl1, A3-B3.
(3) Al-B3, A2-BI, A3-B2. (4) A1-B3, A2-B2, A3-Bl. (il )
35. In this question also, the List A gives some PowerPoint main menu options and the List B
includes an option that can be selected through List A.
List A : Al. Slide Show A2, Review A3. View
List B : Bl. From Beginning B2. Slide Sorter B3. Spelling
A correct matching between the two lists is
(1) Al1-B1, A2-B2, A3-B3. (2) Al-Bl, A2-B3, A3-B2.
(3) A1-B3, A2-Bi, A3-B2. (4) Al-B3, A2-B2, A3-Bl. (e, )
36. Which of the following statements are correct regarding Microsoft PowerPoint?
A — It allows the creation of self-running presentations with narrations.
B - It does not allow to add user defined images as slide backgrounds.
C — To hide slides, one should right-click the required slide and select ‘Hide Slide’.
{1) A and B only (2) A and C only
(3) B and C only 4 AlA, BandC (e )
37. The following image was extracted from a Microsoft PowerPoint interface:
They are
(1) master stide layouts.
(2) slide background types.
(3) slide show types.
(4) slide transition types. )
o y,

[See page eight D
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38.

39.

41.

42,

43.

A video needs to be added to a Microsoft PowerPoint presentation. It could be achieved using
the following tasks done in a proper order:
A - Click ‘Movie from File’, locate the folder that contains the video file, select the
file and then double click the file that you want to add.
B - In ‘Normal View’ click the slide to which the video should be added.
C — On the ‘Insert’ tab, in the ‘Media Clips’ group, click the arrow under ‘Movie’.
Their proper execution order should be
(1) A, B and C. (2) A, C and B. (3) B, A and C. (4 B, C and A. [ (R )

wwwslbelk is
(1) adomain name, (2) ancmail address.
{3) an IP address. (4) a Uniform Resource Locator (URL). SO )

Which of the following are web browsers?
A — Chrome
B - Firefox
C - Firewall
(1) A and B only (2) B and C only
(3) A and C only 4 ANl A, Band C (oevenenn )

Each computer attached to a network should have a unique dot separated number combination.
How it is called?

(1) domain name (2) email address (3) IP address (4) port address Ceoveennnn )

A person wants to learn about Bluefooth using the web. He is advised to do the following
tasks in a proper order:

A — Open the web browser application.
B — Type ‘how bluetooth works’ at the search field.
C - Type www.google.com at the ‘web address’ field.
Their proper execution order should be
(1) A, BandC. (2) A,CandB.
(3) B, Cand A. (4) C,BandA. (PP )

Which of the following statements are correct?

A — A file server provides access to selected files on that computer to other
computers.

B — Electronic commerce has no connection to the Internet.
C — LAN is the abbreviation for Local Area Network.
(1) A and B only (2) A and C only
(3)-B and C only {4 All A, Band C TP )

Which of the following statements are correct?

A — A firewall is a security mechanism placed between an institution’s network and
the Internet to protect the institution’s computers from outside attacks through
the network.

B — A homepage is the main web page of information for an individual or an
institution accessible to others through the World Wide Web.

C - Google is an example of a search engine.
(I} A and B only {(2) A and C only
(3) B and C only (4 All A, Band C Coeeennnns )

[See page nine B
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49.

50.

45. Which of the following is an example of an email address?

46, Which of the following are good practices to follow when using email?

47.

(1) lk@sama.wassanaoffice@
{2) sama@wassanaoffice.lk
(3) sama.lk.wassanaoffice@
{(4) sama.wassanaoffice.lk

A — Deleting received emails that will never be needed again
B — Opening attachments in the emails from strangers
C — Pericdically cleaning up the ‘Sent’ folder

(1) A and B only (2) A and C only
(3) B and C only 4 All A, Band C (

You have received an email and you want to send it as it is to somebody else. Which of
the following options of the email application will you select for the said purpose?

(1) Compose (2) Forward

(3) Reply (4) Search

A person's attempt of sending an email to another person fails. Which of the following are
likely reasons for this?

A — 'The email contains an attachment which is too large for the email application.
B — The recipient's email address is wrong.

C — The sender’s email address is wrong.
(1) A and B only (2) A and C only
(3) B and C only (4) Al A, Band C (cevivanes )

A user types correctly valid email addresses of three of his office colleagues in the To: field

of his email application, writes the email and sends it without any attachment. Then this email
will be sent to

(1) the first recipient only.

(2) the first two recipients only.
(3) all three recipients.

(4 none of the recipients.

Which of the following are benefits of electronic mail over ordinary mail?

A — Easier to include graphics and audio as well

B — Easier to send the same message to multiple recipients

C —~ High-speed transfer

(1) A and B only

(2} A and C only
(3) B and C only

(4) All A, B and C (

J

[See page ten [j
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(

B For each question from No. 51 to 75, write the correct answer on the dotted lines provided.

51. Assume that many important official files are stored in your computer. Give a precaution that you
should take to ensure that they will be available even after a hardware crash of your computer.

....................................................................................................................................
....................................................................................................................................
....................................................................................................................................

....................................................................................................................................

52, It is important not to waste the valuable space of our computer hard disks. Give a good practice that
you would follow in that regard.

...................................................................................................................................

...................................................................................................................................

53. While working on your office computer, you get a request for a short official meeting in another room.
Give a good precaution that you would take to protect your computer’s data while you are away.

....................................................................................................................................
....................................................................................................................................
....................................................................................................................................

...................................................................................................................................

® Suppose you typed the following document using a Word Processor:

Work as if your life is in peril

If you are poor, work
If you are rich, work
If you are sad, wark
if you are happy, work
If you are burdened with seemingly unfair responsibilities, work
If disappointments come, work
If sorrow overwhelms you and loved ones seem not true, work
If health is threatened, work
When dreams are shattered and hope seems dead, work
Work as if your life is in peril. Tt really is.
Work is a great remedy for both mental and physical afflictions.

Swami Vivekananda

Assume that you are using a version of Microsoft Word. A part of its interface is given below:
view o &)
View > Insert~ Format~ Tools~ Table» Referemee ~ Mailings ~  Window -

Al File~ Edit~
IDEE® R BRW I PH I s28F 9 0185 -0 B
BB Z Ui x WK A A% EESEE

A‘i{ gl\}armaf v;"Ef$ [Bac *'“,}
- W,

[See page eleven D
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54.

55.

56.

57.

58.

59.

60.

61.

Labelling the above interface as appropriate, answer the following questions from 54 to 61:

How will you boldface the title?

..................................................................................................................................

...................................................................................................................................

A lazy person asks you how he can change all occurrences of the word ‘work’ in the document to
the word ‘sleep’. Although you do not agree with him, explain him how he can achieve it through
the above Word interface,

How will you increase the letter size of the title?

.............................................................................................................................

..................................................................................................................................

...................................................................................................................................

You decide to add a picture of Swami Vivikananda into the above document. Assuming you downloaded
such a picture into your computer, how will you add it to the document?

...................................................................................................................................
...................................................................................................................................

...................................................................................................................................

...................................................................................................................................

...................................................................................................................................

...................................................................................................................................

...................................................................................................................................

....................................................................................................................................

...................................................................................................................................

J

[See page twelve D
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® Use the following spreadsheet to answer questions from No. 62 to 65.

e B =

{E7
A ] B [ D F G
_1 |HomeGardening . . . ]
2
3 |January 2018
4
5 |StudentNo.| Exam Prac.l Prac.2 Tac AN Finat Mark Grade
&
80 70 75
88 75 05
55 72 73
0
11 _Weights;  [Exam: 0.6
12 Prac: 04
13

The above spreadsheet gives the marks obtained by three students of a home gardening course. The
student evaluation consists of both written exam and practical components. Practical component included
two practical tests of which the average is taken as the practical mark of each student. The final mark
is computed using 60% from the exam mark and the remaining 40% from the average practical mark.

62. Write down the formula for cell E7 to compute the average practical mark for the student 2014/1.

...................................................................................................................................
...................................................................................................................................
...................................................................................................................................

...................................................................................................................................

63. Write down the formula for cell F7 to compute the final mark of the student 2014/1.
(Note: Your formula should include the use of cells C11 and C12 100.)

...................................................................................................................................
...................................................................................................................................
...................................................................................................................................

...................................................................................................................................

64. Write down the formula for cell G7 to show the grade of the student 2014/1.
(Note: If Final mark is = 50 then the grade is ‘Pass’ else it is ‘Fail’ is used.)

...................................................................................................................................
..................................................................................................................................
...................................................................................................................................

...................................................................................................................................

\.. J

[See page thirteen B
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65. The above formulas can be used to complete the relevant cells for the other students tco. Write down

how you would use the formula that you wrote for cell E7 under Question 62 to compute the average
practical mark of each of the other students.

.............................................................................................................

® Use the following database to answer questions No. 66 and 67.

An employee in a company plans to have the following table in a database to store information about
the company’s customers and their sales representatives.

Cust_No Cast Hame Cast Address| Cuat City |[Cust Balares 8 Rep No 1 # Rep Name | 8 Hep Phone
co0l Bams Perera 1™ Lane ¥assanagans Rs.80860 §B01 Rajah 0112223333
coo2 Iamars Fernande 2™ Lang Wassanagame | He. 7900 00z Faliin D233334444
ches Rajah Sinmathamby |1 Lane Wassanagama |  Re.3000  |SOD1 Radah bi1z223333
co04 IFazeel Mohammed [3* Lane Suriyagama | Re.300¢ 15001 lRajah f112223333

66. Explain why the above design is undesirable.

.......................................

® The questions No. 68 and 69 deal with electronic presentations.

68. It is recommended to limit the text lines on a presentation slide to between 5-9. Explain whether you
agree with it,

........................

[See page fourteen. D
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69. Given below is a portion of a Microsoft PowerPoint interface that you could use to build a presentation:

70. A Grama Niladhari wants to start a website to provide ar improved service to people. Suggest two
important items that he should include on his homepage.

() e cereean e et e trat et et rt e tee e eenannaans crrbenas ereeens crreanees

71. An institution that provides internet access is known as an internet service provider (ISP). Give an
example of a Sri Lankan ISP.

LR Sruman Cesanas tranns LR S sevianas Casanna LEE TR TereEsaianes L R A trrana Cessasc et aua

72. Give two examples of internet misuse at an office.

(1) e e e

. /

[See page fifieen. G
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® Given below is the compose interface of an email application to write a new email, Labelling it as
appropriate, answer questions No. 73 to 75,

New Message

To:
Subject:

samsmait viqT-iB 7 W A-IE-EE BB WL

Assume that you have to send an email to Sama using the above interface.

73. Where on the interface will you type the email address of Sama?

...................................................................................................................................

74. Assume you have to attach the budget.pdf file to your email. Write down the two steps that you
would follow to do it.

75. What will you do to send your email?

...................................................................................................................................

...................................................................................................................................







